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      Podziękowania

    


    Przede wszystkim dziękujemy naszym rodzicom, Walterowi i Beryl Fenlonom, oraz Mike’owi i Marlene Hawleyom, bez których miłości i wsparcia nie bylibyśmy tymi, kim teraz jesteśmy.


    Podziękowania należą się również zespołowi wydawnictwa O’Reilly — zwłaszcza Brianowi Sawyerowi za całą ciężką pracę, jaką włożył w tę książkę. Musimy podziękować Andy’emu Pope’owi oraz Dennisowi Wallentinowi za sposoby na Excela, w które nas wtajemniczył, oraz wspomnieć o wszystkich osobach odwiedzających naszą witrynę WWW i forum dyskusyjne, dzięki którym poznaliśmy problemy najczęściej napotykane przez użytkowników.


    Chcielibyśmy również złożyć specjalne podziękowania wszystkim moderatorom oraz australijskim MVP z naszego forum pytań i odpowiedzi, którzy dzielą swój czas i wiedzę w tak bezinteresowny sposób. Na końcu musimy podziękować Aleishy i Kate, które zawsze są dla nas inspiracją. Nigdy nie zapomnimy ich zrozumienia i wysiłków, by zachowywać się grzecznie, czynionych w czasie, gdy powstawała ta książka.

  


  
    
      O Autorach

    


    David i Raina Hawley prowadzą firmę OzGrid Business Applications działającą w zachodniej Australii, która świadczy usługi w zakresie tworzenia aplikacji biznesowych oraz prowadzenia szkoleń i warsztatów dotyczących Excela i VBA dla Excela.


    David Hawley od ponad 15 lat dzień w dzień tworzy aplikacje biznesowe w Excelu i VBA dla Excela. Co miesiąc opracowuje biuletyn opisujący sposoby korzystania z Excela i VBA dla Excela, a także prowadzi i utrzymuje popularne forum dyskusyjne znajdujące się na witrynie firmy OzGrid.


    Raina Hawley prowadzi szkolenia w firmach oraz szkołach wyższych i jest certyfikowanym inspektorem pracy. Raina prowadzi biuro firmy OzGrid i zajmuje się wszelkimi sprawami administracyjnymi jej dotyczącymi, a także wraz z mężem opracowuje narzędzia oparte na Excelu. Oboje mają w swej ofercie setki dodatków do Excela oraz programów służących do analizy danych, przeznaczonych dla firm ze wszystkich branż. Produkty te dostępne są na witrynie internetowej http://www.ozgrid.com. Raina i David mieszkają wraz z dwiema córkami w Bunbury w zachodniej Australii.


    
      
        O Współpracownikach

      


      Wymienione poniżej osoby podzieliły się z autorami swoimi umiejętnościami, pomagały w pisaniu tej książki i stanowiły inspirację dla jej twórców:


      
        
          	Andy Pope jest programistą pracującym w Londynie. Komputerów używa od połowy lat 80. ubiegłego wieku. Jego bieżąca praca obejmuje pisanie spersonalizowanych rozwiązań do raportowania projektów przy wykorzystaniu narzędzi pakietu MS Office oraz VBA. Prowadzi również własną stronę internetową, znajdującą się pod adresem http://www.andypope.info/. Jego wkład i poświęcenie dla środowiska użytkowników Excela zostały docenione przez firmę Microsoft, która przez cztery ostatnie lata nadawała mu tytuł MVP.


          	Dennis Wallentin pracuje jako niezależny konsultant ds. Excela od końca lat 80. Wykorzystuje Excela oraz inne narzędzia do tworzenia profesjonalnych rozwiązań dla firm każdej wielkości, w tym sektora publicznego, zarówno w Szwecji, jak i w innych krajach na całym świecie. Obecnie jego uwaga skupia się na narzędziu Visual Studio Tools for Office System (VSTO). Dennis posiada dyplom magistra w zakresie finansów i księgowości. Prowadzi również angielską stronę internetową oraz blog, które znajdują się odpowiednio pod adresami: http://www.excelkb.com oraz http://xldennis.wordpress.com.

        

      

    

  


  
    
      Przedmowa

    


    Miliony użytkowników Excela codziennie tworzy i wymienia się arkuszami kalkulacyjnymi. Arkusze te, na początku traktowane jak jeszcze jedno udogodnienie, z czasem coraz częściej zaczęły być wykorzystywane jako narzędzia wspomagania decyzji biznesowych.


    Choć trudno przecenić znaczenie Excela, większość użytkowników zna jedynie część dostępnych w nim możliwości. Użytkownicy ci korzystają jedynie z tych narzędzi, których potrzebują, a za źródło bardziej skomplikowanych mechanizmów uznają szablony arkuszy i nie wgłębiają się w bardziej zaawansowane możliwości Excela. Oznacza to, że wiele osób nigdy nie pozna możliwości programu na tyle dobrze, by zidentyfikować rozwiązania, dzięki którym znacznie ułatwiłyby sobie pracę.


    Wraz z nowym pakietem MS Office 2007 na rynku pojawiła się nowa wersja Excela. Można znaleźć w nim wiele zmian, a najbardziej oczywistą jest nowy interfejs użytkownika. Wprowadzenie wstążek zaowocowało powstaniem zorientowanego na wyniki interfejsu, który w przejrzysty i zorganizowany sposób wyświetla narzędzia, kiedy te są potrzebne. Dodatkowo znacznemu powiększeniu uległ rozmiar samego arkusza, który teraz może składać się maksymalnie z 16 tys. kolumn oraz ponad miliona wierszy. Zwiększył się także całkowity rozmiar pamięci, z jakiej może korzystać Excel; ograniczony jest on w tym momencie do wielkości pamięci, jakiej system Windows pozwoli użyć.


    Inne usprawnienia obejmują łatwiejsze korzystanie z mechanizmu tabel przestawnych, formatowania warunkowego i nazw zakresów, podglądów „na żywo”, galerii predefiniowanych stylów, formatów tabel oraz grafik SmartArt, dzięki czemu użytkownik może wykorzystywać w swoich arkuszach bardziej skomplikowane elementy wizualne i graficzne. Ponieważ większość użytkowników musi pracować z wieloma różnymi aplikacjami, współdzielić arkusze i być podłączona do sieci, Excel 2007 ułatwia te czynności i czyni je znacznie łatwiejszymi do zarządzania.


    W niniejszej książce po raz kolejny przedstawione zostały sytuacje z życia wzięte. Chociaż Excel 2007 używany był jako podstawa dla niemal wszystkich zawartych w niniejszej publikacji sposobów, to większość z nich można wykorzystać również w poprzednich wydaniach tej aplikacji, a kilka ze sposobów dotyczy jedynie wcześniejszych wersji. Różnice są zaznaczone w tekście, a większość starych elementów menu wciąż można odnaleźć, choć w innym miejscu i czasami pod nieco inną nazwą.


    
      
        Po co nam sposoby w Excelu?

      


      Znakomitą większość zadań można wykonać, korzystając jedynie z najprostszych narzędzi Excela, lecz program ten udostępnia również wiele mechanizmów o znacznie większych możliwościach. Dzięki nim nawet bez wieloletniego poznawania i używania Excela można uzyskać efekty wybijające się ponad przeciętność. Większość użytkowników skupia się jednak na tworzonej zawartości: danych i formułach, ewentualnie wykresach, przez co bardziej zaawansowane funkcje Excela wydają im się wysoce skomplikowane.


      Istnieje wiele metod takiego wykorzystania narzędzi Excela, by znacząco poszerzyć możliwości tworzenia efektownych arkuszy kalkulacyjnych, bez konieczności poświęcania im długich lat nauki. Metody te, czyli sposoby — szybkie i niezbyt wyrafinowane rozwiązania problemów albo sprytne formy wykonania jakichś czynności — zostały wymyślone przez użytkowników Excela poszukujących prostych rozwiązań dla skomplikowanych problemów. Sposoby przedstawione w tej książce zostały tak dobrane, by pokazać, co można w programie zrobić i jak osiągać natychmiastowe efekty.


      Przedstawiane sposoby można wykorzystywać dwojako. Po pierwsze, sposób można wykorzystać bezpośrednio w trakcie tworzenia lub ulepszania arkuszy kalkulacyjnych. Druga metoda sprowadza się do przeanalizowania sposobu i ewentualnie wykorzystania niektórych możliwości języka Visual Basic for Applications (VBA), dzięki czemu możliwe będzie precyzyjne dostosowanie sposobu do własnych potrzeb.

    


    
      
        Pobieranie i korzystanie ze sposobów

      


      Aby oszczędzić czas Czytelnika i nie zmuszać go do ręcznego wpisywania skryptów i tworzenia arkuszy, wszystkie przedstawione sposoby (z wyjątkiem tych, które sprowadzają się do napisania jedynie kilku wierszy kodu bądź wykorzystania elementów interfejsu graficznego) można pobrać z witryny WWW autorów, znajdującej się pod adresem http://www.ozgrid.com/BookExamples/excel-hack2-examples.htm.


      Czytelnik zapewne będzie chciał wycinać i wklejać części prezentowanych rozwiązań oraz modyfikować je we własnych arkuszach, by lepiej spełniały jego wymagania. Arkusze Excela mogą mieć różnorodną postać i przedstawiane sposoby będą zapewne do niej dostosowywane.

    


    
      
        Jak korzystać z niniejszej książki

      


      Książka jest podzielona na rozdziały przedstawione pokrótce w następnym punkcie, można jednak z niej korzystać na wiele różnych sposobów. Można ją potraktować jak zbiór gotowych rozwiązań i rozpocząć lekturę od sprawdzenia, jakie sposoby prezentowane są w kolejnych rozdziałach. Następnie, gdy pojawi się taka potrzeba, można po prostu wykorzystać odpowiedni sposób do opracowania własnego rozwiązania. Można również zdecydować się na przejrzenie lub przeczytanie od razu całej książki od deski do deski, analizując przedstawiane procedury i skrypty i poznając jednocześnie możliwości Excela. Szczególnie przydatne okażą się wówczas sposoby zawierające kompletne instrukcje realizacji bardziej skomplikowanych zadań lub bogato udokumentowane skrypty. Jeszcze inne podejście może polegać na wybraniu pojedynczego rozdziału i sprawdzeniu, które z prezentowanych w nim rozwiązań okaże się najbardziej przydatne w danej sytuacji lub może przydać się w przyszłości.

    


    
      
        Jak zorganizowano książkę

      


      Bez względu na to, w jaki sposób Czytelnik będzie korzystał z tej książki, najpierw zapewne zechce sprawdzić, co się w niej znajduje. Poniżej przedstawiamy więc krótki opis każdego rozdziału i poruszanych w nim zagadnień:


      
        
          	Rozdział 1


          	
            Skoroszyty i arkusze stanowią główny interfejs pozwalający na pracę z danymi w Excelu, czasami jednak zbiory ogromnych, pustych tabel nie działają tak, jak użytkownik by sobie tego życzył. Prezentowane w rozdziale sposoby pozwalają zarządzać pracą użytkowników z arkuszami, pomagają znajdować i wyróżniać informacje oraz pokazują, jak radzić sobie w trudnych sytuacjach.

          


          	Rozdział 2


          	
            Excel posiada szereg wbudowanych mechanizmów do analizy i zarządzania danymi. Mechanizmy te zawierają jednak często różnego rodzaju ograniczenia. Sposoby prezentowane w tym rozdziale umożliwiają rozszerzanie i automatyzację wbudowanych mechanizmów Excela, tak by znacznie wzbogacić ich pierwotne możliwości.

          


          	Rozdział 3


          	
            Odwołania do komórek mające postać A2 czy IV284:IN1237 niewątpliwie są przydatne, lecz w miarę powiększania się arkusza kalkulacyjnego często łatwiejsze okazuje się odwoływanie się do danych przy użyciu nazw. Prezentowane sposoby nie tylko dotyczą sposobu nazywania komórek i zakresów komórek, lecz również obrazują metody tworzenia takich nazw, które będą pasować do danych znajdujących się w arkuszu.

          


          	Rozdział 4


          	
            Dla wielu użytkowników Excela tabela przestawna już sama w sobie jest niezwykle skomplikowanym trikiem. Rozwiązania prezentowane w tym rozdziale ukazują sposoby wykorzystywania do maksimum możliwości tabel przestawnych, unikania związanych z nimi problemów, a także poszerzania ich możliwości.

          


          	Rozdział 5


          	
            Wbudowane mechanizmy Excela odpowiedzialne za tworzenie wykresów są niezwykle użyteczne, lecz nie zawsze stanowią najlepszą metodę prezentacji danych. Opisywane sposoby pokazują, jak można wykorzystywać i łączyć mechanizmy tworzenia i dostosowywania wykresów w Excelu, tak by samodzielnie tworzyć wykresy spełniające konkretne wymagania.

          


          	Rozdział 6


          	
            Formuły i funkcje to najważniejsze elementy każdego arkusza kalkulacyjnego, lecz czasami sposób ich obsługi w Excelu nie do końca jest zgodny z wymaganiami użytkowników. Przedstawione w tym rozdziale sposoby dotyczą szerokiego zakresu zagadnień: od przenoszenia formuł do dostosowywania typów danych w taki sposób, by przyspieszyć czas wykonywanych obliczeń.

          


          	Rozdział 7


          	
            Makra (i skrypty VBA) to swego rodzaju tylne wyjście w Excelu, umożliwiające tworzenie arkuszy o możliwościach znacznie wykraczających poza standardowe możliwości Excela lub opracowywanie arkuszy, które bardziej przypominają program komputerowy. Prezentowane sposoby pozwalają wykorzystać wszystkie możliwości makr, począwszy od zarządzania nimi, a skończywszy na używaniu ich w celu rozszerzania dostępnych możliwości.

          


          	Rozdział 8


          	
            Choć większość arkuszy jest samowystarczalna, to w rozdziale tym pokazane jest, w jaki sposób współpracować z innymi aplikacjami pakietu Microsoft Office, by pobierać dane do arkusza Excela i wysyłać je do innych aplikacji.

          

        

      

    


    
      
        Użytkownicy systemów Windows, komputerów Macintosh oraz wcześniejszych wersji Excela

      


      Sposoby prezentowane w tej książce zostały opracowane z myślą o Excelu 2007 i były testowane na wcześniejszych wersjach Excela pracującego z systemem Windows oraz na komputerach Macintosh wyposażonych w arkusz Excel 2004. Tam, gdzie poszczególne kroki sposobu lub opcje menu różnią się w zależności od wersji, główny tekst pokazuje, jak wykorzystać sposób w Excelu 2007, a instrukcje dotyczące wersji wcześniejszych znajdują się w uwagach lub w nawiasach.


      Większość różnic między obiema platformami ma charakter kosmetyczny i często sprowadza się do stosowanych skrótów klawiaturowych lub menu. W przypadku, gdy kombinacje klawiszy się różnią, najpierw prezentowana jest opcja dla systemu Windows; na przykład Alt/Command([image: ])+Q oznacza kombinację Alt+Q w Windows oraz [image: ]+Q na komputerze Macintosh. W kilku przypadkach, zwłaszcza w edytorze Visual Basic Editor, różnice dotyczą wyglądu interfejsu i poleceń dostępnych w menu — tego typu rozbieżności są od razu sygnalizowane. Kilka sposobów dotyczy wyłącznie wersji dla Windows, ponieważ odwołują się do rejestru systemu Windows lub innych narzędzi charakterystycznych dla Excela dla Windows. Przypadki te również zaznaczane są w tekście.


      Użytkownicy komputerów Macintosh korzystający z myszy posiadającej tylko jeden przycisk powinni pamiętać, że wciśnięcie klawisza Ctrl i kliknięcie myszą odpowiada kliknięciu prawym przyciskiem myszy (użytkownicy Macintoshy posiadający myszy z dwoma przyciskami lub większą ich liczbą klikają jej prawym przyciskiem w zwykły sposób). Najnowsze modele komputerów Apple MacBook oraz MacBook Pros pozwalają zdefiniować kliknięcie prawym klawiszem myszy poprzez przytrzymanie dwóch palców na „touchpadzie” i kliknięcie. Możliwość ta musi być jednak wcześniej uaktywniona w ustawieniach systemu.


      Większość prezentowanych sposobów powinna działać w każdej wersji Excela, począwszy od Excela 97. Jeśli tak nie będzie, w tekście zamieszczona zostanie odpowiednia informacja. Zrzuty ekranu były wykonywane w Excelu 2007, ale w żaden sposób nie determinują wersji programu, w jakiej działa opisywany sposób.

    


    
      
        Konwencje zastosowane w książce

      


      W książce zastosowano następujące konwencje typograficzne:


      
        
          	Tekst pochylony


          	
            Wskazuje adresy URL, adresy poczty elektronicznej, nazwy plików, rozszerzenia plików, ścieżki dostępu, nazwy katalogów, nazwy i polecenia menu, nazwy przycisków i klawiszy (na przykład Alt czy Ctrl).

          


          	Tekst o stałej szerokości znaku


          	
            Używany w przypadku poleceń, opcji, przełączników, zmiennych, atrybutów, funkcji, typów, przestrzeni nazw, metod, modułów, właściwości, parametrów, wartości, obiektów, zdarzeń, uchwytów zdarzeń, znaczników XML i HTML, makr, zawartości plików, danych wynikowych poleceń, identyfikatorów komórek oraz nazw zakresów.

          


          	Pogrubiony tekst o stałej szerokości znaku


          	
            Używany w przypadku poleceń lub innego rodzaju tekstu, który powinien być wpisany przez użytkownika w postaci dosłownej. Wykorzystywany również do zaznaczenia szczególnie ważnych wierszy kodu.

          


          	Pogrubiony i pochylony tekst o stałej szerokości znaku


          	
            Używany w przykładach, tabelach i poleceniach; oznacza tekst, w miejsce którego użytkownik powinien wpisać konkretne wartości.

          

        

      


      Szczególną uwagę należy zwrócić na fragmenty wyodrębnione z tekstu za pomocą następujących ikon:


      
        


        Podpowiedź


        Ta ramka zawiera poradę, sugestię lub ogólną uwagę.

        

      


      
        


        Ostrzeżenie


        Ta ramka zawiera przestrogę lub ostrzeżenie.

        

      


      Ikony termometrów, umieszczane obok tytułu każdego sposobu, wskazują stopień trudności prezentowanego tematu:


      
        
          
            
            
            
            
            
            
          

          
            
              	
                [image: ]

              

              	
                dla początkujących

              

              	
                [image: ]

              

              	
                dla średnio zaawansowanych

              

              	
                [image: ]

              

              	
                dla ekspertów

              
            

          
        

      


      Poniższe ikony, umieszczane poniżej każdego sposobu, wskazują, do których wersji Excela dany sposób ma zastosowanie:


      
        
          
            
            
          

          
            
              	
                Wszystkie

              

              	
                Sposób działa ze wszystkimi wersjami Excela.

              
            


            
              	
                2007

              

              	
                Sposób działa jedynie z Excelem 2007.

              
            


            
              	
                <2007

              

              	
                Sposób działa z wersjami wcześniejszymi niż Excel 2007.

              
            


            
              	
                2003

              

              	
                Sposób działa z Excelem 2003.

              
            


            
              	
                2000

              

              	
                Sposób działa z Excelem 2000.

              
            

          
        

      

    


    
      
        Używanie przykładowych kodów źródłowych

      


      Zadaniem tej książki jest pomóc Czytelnikowi w wykonaniu zadania. Można więc używać prezentowanych w niej kodów źródłowych we własnych programach i dokumentacji. Nie trzeba zwracać się do nas o pozwolenie, chyba że Czytelnik zamierza dokonać reprodukcji znacznych części kodu. Na przykład: jeśli Czytelnik pisze program, w którym używa kilku fragmentów kodu z książki, nasze pozwolenie nie jest potrzebne, lecz sprzedaż lub dystrybucja płyty CD-ROM z przykładami pochodzącymi z książek Wydawnictwa Helion wymaga takiego pozwolenia. Opracowywanie odpowiedzi na pytania zawierającej cytaty z tej książki oraz przytaczającej przykłady kodu źródłowego nie wymaga pozwolenia, natomiast dołączanie do dokumentacji opracowanego produktu znacznej części kodu źródłowego pochodzącego z tej książki wymaga pozwolenia.


      Jeśli Czytelnik nie jest pewien, czy sposób wykorzystania przez niego fragmentów kodów źródłowych nie narusza prawa lub zasad opisanych powyżej, należy skontaktować się z Wydawnictwem Helion pod adresem helion@helion.pl.

    

  


  
    
      Rozdział 1. Ujarzmianie skoroszytów i arkuszy: Sposoby 1. – 16.

    


    Użytkownicy Excela wiedzą, że skoroszyty dają ogromne możliwości. Większość z nich zdaje sobie jednak również sprawę, że praca ze skoroszytami może przysporzyć wielu problemów. Sposoby prezentowane w tym rozdziale będą opierać się na bardziej efektywnych, choć często zapominanych metodach kontrolowania skoroszytu, które pozwolą uniknąć większości typowych problemów.


    Zanim jednak przejdziemy do przedstawienia sposobów na Excela, wspomnijmy najpierw o kilku podstawowych zasadach, znacznie ułatwiających tworzenie efektywnych trików i sposobów. Excel jest niezwykle rozbudowanym arkuszem kalkulacyjnym, w którym można tworzyć rzeczy wręcz niezwykłe. Niestety, większość użytkowników tworzy własne arkusze Excela, nie troszcząc się o przyszłość, a tym samym znacznie ogranicza sobie możliwość ich ponownego wykorzystywania i uaktualniania. W kolejnych kilku punktach przedstawimy kilka porad, których przestrzeganie zagwarantuje, że tworzone arkusze będą tak wydajne, jak to tylko możliwe.


    
      
        Reguła 80/20

      


      Chyba najważniejszą sprawą, o której trzeba pamiętać w trakcie projektowania arkusza kalkulacyjnego, jest to, by myśleć o nim w kategoriach długookresowych i nigdy z góry nie zakładać, że do arkusza tego nie będą dopisywane żadne dodatkowe dane ani formuły, bo najprawdopodobniej okaże się to nieprawdą. Pamiętając o tym, należy poświęcić 80% czasu na zaplanowanie konstrukcji arkusza, a 20% — na jego zbudowanie. Na pierwszy rzut oka postępowanie takie może wydawać się całkowicie nietrafione, lecz można być pewnym, że wynikające z niego korzyści, osiągane w dłuższym okresie, znacznie przewyższą niedogodności odczuwane na początku, a poświęcenie nawet kilku chwil na zaplanowanie pracy znacznie ją ułatwi. Nie można zapominać również o tym, że rolą arkuszy jest ułatwienie ich użytkownikom odczytywania prawidłowych informacji, a nie tylko jednorazowe ich zaprezentowanie.

    


    
      
        Porady dotyczące struktury arkuszy

      


      Bez wątpienia głównym grzechem popełnianym przez większość użytkowników Excela jest to, że w tworzonych przez siebie arkuszach rozmieszczają oni dane w sposób odmienny od tego, jaki przewidziano w samym programie i jego narzędziach. Poniżej w przypadkowej kolejności przedstawiono najczęstsze błędy popełniane przez użytkowników w trakcie tworzenia arkuszy:


      
        
          	Nieuzasadnione rozpraszanie danych w wielu różnych skoroszytach.


          	Nieuzasadnione rozpraszanie danych w kilku arkuszach.


          	Nieuzasadnione rozpraszanie danych w różnych tabelach.


          	Umieszczanie w tabelach z danymi pustych wierszy i kolumn.


          	Pozostawianie pustych komórek dla danych powtarzających się.

        

      


      Pierwsze trzy punkty na powyższej liście można skwitować jednym stwierdzeniem: zawsze powinno się umieszczać powiązane ze sobą dane w jednej tabeli. Co i rusz mamy do czynienia z arkuszami, które są na bakier z tą prostą zasadą i przez to nie mogą korzystać w pełni z dobrodziejstw niektórych najbardziej zaawansowanych narzędzi Excela, takich jak tabele przestawne, sumy pośrednie czy formuły. Narzędzia te można w pełni wykorzystywać jedynie wówczas, gdy przetwarzane dane znajdują się w pojedynczej, zwykłej tabeli.


      To nie przypadek, że arkusze Excela mieszczą 1 048 576 (w wersjach wcześniejszych 65 536) wierszy i tylko 16 384 (w wersjach wcześniejszych 256) kolumny. Z tego względu powinno się tworzyć tabele, których nagłówki znajdować się będą w pierwszym wierszu, a odpowiednie dane będą zapisane w sposób ciągły zaraz pod odpowiadającymi im nagłówkami. Jeśli okaże się, że po raz kolejny wpisywane są te same dane co poprzednio, pod żadnym pozorem nie można ulec pokusie, by takie powtarzające się wartości pominąć i zostawić na ich miejscu puste komórki.


      Zawsze, gdy jest to możliwe, należy sortować dane. Excel udostępnia szeroki zbiór funkcji wyszukiwania i odwoływania się do danych, których część wymaga wcześniejszego, logicznego posortowania. Uporządkowanie danych znacznie przyspiesza również działanie większości funkcji obliczeniowych.

    


    
      
        Porady dotyczące formatowania

      


      Oprócz struktury arkuszy problemem może okazać się również sposób ich formatowania. Arkusz powinien co prawda być czytelny i zrozumiały, nigdy jednak nie powinno to prowadzić do pogorszenia jego wydajności. Jesteśmy gorącymi zwolennikami zasady, by dążyć do jak największej prostoty. Ogromne rzesze użytkowników spędzają wiele czasu tylko na formatowaniu arkuszy i choć zapewne nie zdają sobie z tego sprawy, to ich działania negatywnie odbijają się na wydajności obliczeń. W wielu przypadkach nadmierne formatowanie danych zwiększa rozmiar skoroszytu i choć w efekcie dla autora może on wyglądać jak dzieło sztuki, to inny użytkownik będzie nim zdegustowany. Często warto jest ograniczyć się do stosowania w arkuszach kolorów uniwersalnych: czarnego, białego i szarego.


      W wielu przypadkach dobrym pomysłem okazuje się również pozostawienie nad tabelą trzech pustych wierszy (przynajmniej trzech, a nawet więcej). Później będzie można w nich wpisać kryteria wykorzystywane przez narzędzia, takie jak Filtr zaawansowany czy funkcje kategorii Bazy danych.


      Wielu użytkowników nadużywa wyrównywania danych zapisanych w komórkach. Domyślnie liczby znajdujące się w Excelu są wyrównywane do strony prawej, a tekst jest wyrównywany do lewej i istnieją ważne powody, by tego nie zmieniać. Jeśli ten domyślny sposób formatowania zostanie zmieniony, użytkownik będzie potem potrzebował chwili, by zorientować się, czy w komórce znajdują się dane liczbowe, czy tekstowe. Często zdarza się, że użytkownicy odwołują się do komórek, które na pierwszy rzut oka wydają się zawierać liczby, a dopiero później okazuje się, że są to dane tekstowe. Jeśli twórca arkusza zdecyduje się zmienić formatowanie domyślne, prędzej czy później sam będzie drapać się po głowie, zastanawiając się, co zawiera dana komórka. Od przytoczonej zasady wyjątkiem mogą być jedynie nagłówki.


      Dane znajdujące się w komórkach można formatować jako tekst tylko wówczas, gdy jest to bezwzględnie konieczne. Wszystkie dane sformatowane w komórkach jako tekst stają się tekstem, nawet jeśli w zamierzeniach miały one być liczbami czy datami. Co gorsza, każda komórka zawierająca formułę odwołującą się do komórki zawierającej dane tekstowe również zostanie sformatowana jako tekst. A przecież nie chcemy, by formuły były traktowane jak zwykły tekst!


      Problemem mogą być również komórki scalone. Baza wiedzy firmy Microsoft pełna jest opisów problemów wiążących się ze scalaniem komórek. Zamiast scalania można używać wyrównywania do środka, które znaleźć można na karcie Narzędzia główne w grupie Wyrównanie. Strzałka znajdująca się w prawym dolnym rogu wyświetli okno dialogowe Formatowanie komórek z otwartą zakładką Wyrównanie. Korzystając z listy rozwijanej Poziomo, należy ustawić opcję Wyrównaj zaznaczenie do środka. Można również kliknąć prawym przyciskiem myszy na komórce i z menu kontekstowego wybrać polecenie Formatuj komórki (w wersjach wcześniejszych należy użyć menu Formatuj→Komórki).

    


    
      
        Porady dotyczące formuł

      


      Kolejnym poważnym błędem popełnianym przez użytkowników w formułach Excela, jest odwoływanie się do całych kolumn. Zmusza to program do analizowania w niektórych przypadkach nawet tysięcy, jeśli nie milionów komórek, które z czystym sumieniem można by zupełnie pominąć.


      Załóżmy na przykład, że mamy tabelę z danymi zajmującymi zakres komórek od A1 do H1000 i decydujemy się na użycie jednej lub kilku funkcji wyszukiwania, aby znaleźć wymagane informacje. Ponieważ w miarę dodawania danych tabela ta może cały czas się powiększać, często stosowane są w takich przypadkach odwołania do całej tabeli i wszystkich jej wierszy. Inaczej mówiąc, odwołania takie mają postać A:H albo A1:H65536. Użytkownicy stosują takie odwołania po to, by w przypadku dodania do tabeli nowych danych automatycznie były one uwzględniane w utworzonej formule.


      Działanie takie jest bardzo złą praktyką i należy się jej wystrzegać niemal za wszelką cenę. Znacznie lepszym rozwiązaniem będzie użycie dynamicznych zakresów nazw.


      Kolejnym, częstym problemem wynikającym z wadliwej konstrukcji arkusza są przeciągające się w czasie obliczenia. Wielu użytkowników twierdzi, że rozwiązaniem jest przełączenie w oknie dialogowym Przycisk Office→Opcje programu→Formuły (w wersjach wcześniejszych: Narzędzia→Opcje→Przeliczanie; w systemach Mac OS X: Excel→Properties→Calculation) trybu przeliczania na Ręcznie.


      Zwykle jednak rada ta okazuje się mało skuteczna i niesie ze sobą groźbę poważniejszych komplikacji. Główną ideą arkusza jest stosowanie formuł i obliczeń, a efektem jego używania mają być ich wyniki. Jeśli tworzony arkusz działa w ręcznym trybie przeliczania, prędzej czy później użytkownik zorientuje się, że prezentuje on dane nieaktualne. Wyniki formuł mogą opierać się na starych danych, a nie danych uaktualnionych — wynika to z faktu, że jeśli Excel działa w ręcznym trybie przeliczania, zawsze trzeba nakazać mu ponowne przeliczanie, naciskając klawisz F9 ([image: ]+= na komputerach z systemem Mac OS X). Łatwo jednak o tym zapomnieć! Spójrzmy na to w inny sposób. Gdyby hamulce w naszym samochodzie były źle ustawione i spowalniały jazdę, to czy odłączalibyśmy pedał hamulca i korzystali tylko z hamulca ręcznego, czy też dążylibyśmy do usunięcia problemu? Większości z nas to pierwsze rozwiązanie w ogóle nie przyszłoby do głowy, lecz wielu użytkowników nie ma żadnych zahamowań, by przełączyć arkusz w tryb ręcznego przeliczania. Jeśli z czasem wzrasta poczucie, że lepiej byłoby włączyć przeliczanie ręczne, oznacza to, że arkusz jest wadliwie zaprojektowany. Lepiej spróbować to naprawić, a nie korzystać z rozwiązań zastępczych.


      Kolejnym źródłem licznych problemów są formuły tablicowe. Najlepiej nadają się one do odwoływania się do pojedynczych komórek. Jeśli trzeba odwołać się w nich do większych zakresów komórek, powinno się to robić jak najrzadziej. Gdy większa liczba formuł tablicowych odwołuje się do zakresów komórek, wydajność obliczeń w skoroszycie znacznie się obniża — nierzadko do takiego poziomu, że staje się on bezużyteczny i trzeba przełączyć go w tryb przeliczania ręcznego.


      Doskonałą alternatywą dla formuł tablicowych często okazują się funkcje bazy danych, przedstawione na przykład w części „Sposób 79. Wszystkie Sumowanie lub zliczanie komórek z pominięciem wartości błędnych”. Sposoby ich wykorzystania względem dużych tabel danych w celu znalezienia danych spełniających wielorakie kryteria są również opisane w pomocy Excela. Kolejnym alternatywnym rozwiązaniem, często zresztą niedocenianym, są tabele przestawne zaprezentowane w Rozdział 4. Choć na początku łatwo się do nich zrazić, gorąco zachęcamy do ich poznania, bo gdy tylko zrozumie się ich działanie, trudno będzie uwierzyć, jak wcześniej można było radzić sobie bez nich!


      Na zakończenie, gdy przedstawiliśmy już najważniejsze informacje na temat projektowania arkuszy, powtórzmy jeszcze raz: Excel działa najlepiej wówczas, gdy wszystkie powiązane ze sobą dane znajdują się w jednej, ciągłej tabeli. Trzymanie się tej zasady znacznie ułatwi dalszą pracę z Excelem.

    


    
      
        Sposób 1. Wszystkie Tworzenie własnego widoku skoroszytów

      


      
        

        [image: image with no caption]

      


      
        
          Excel potrafi wyświetlać kilka skoroszytów naraz, a ich okna można rozmieszczać na ekranie na różne sposoby. Utworzony widok obszarów roboczych można następnie zapisywać w plikach .xlw i używać w sytuacjach, w których okażą się najbardziej wygodne.

        

      


      Czasami w trakcie pracy w Excelu dobrze jest mieć otwartych na ekranie więcej skoroszytów niż jeden. Znacznie ułatwi to jednoczesne ich używanie i przeglądanie. W kilku następnych punktach pokażemy, jak się do tego zabrać w sposób sprytny i zorganizowany.


      Na początek należy otworzyć wszystkie skoroszyty, które będą potem potrzebne.


      
        


        Podpowiedź


        Aby otworzyć kilka skoroszytów naraz, należy kliknąć Przycisk Office→Otwórz..., trzymając wciśnięty klawisz Ctrl (klawisz [image: ] w komputerach Mac), zaznaczyć wszystkie skoroszyty, które mają zostać otwarte, po czym nacisnąć przycisk Otwórz (w wersjach wcześniejszych trzeba kliknąć Plik→Otwórz).

        

      


      W którymś z otwartych skoroszytów (obojętnie którym) należy kliknąć kartę Widok, a następnie w grupie Okno wybrać polecenie Rozmieść wszystko (w wersjach wcześniejszych należy wybrać polecenie Okno→Rozmieść). Jeśli zaznaczone jest pole wyboru Okna aktywnego skoroszytu, trzeba je wyczyścić. Następnie należy zaznaczyć preferowany sposób rozmieszczenia okien i kliknąć przycisk OK.


      Jeśli zaznaczone zostało pole Sąsiadująco, otwarte skoroszyty zostaną rozmieszczone w taki sposób, by sąsiadowały ze sobą — tak jak puste skoroszyty widoczne na Rysunek 1-1.


      Zaznaczenie pola Poziomo spowoduje, że wszystkie skoroszyty zostaną wyświetlone w postaci stosu, jeden nad drugim, jak na Rysunek 1-2.


      Jeśli wybrana została opcja Pionowo, wszystkie otwarte skoroszyty zostaną rozmieszczone jeden obok drugiego, jak na Rysunek 1-3.


      Z kolei wybranie opcji Kaskadowo spowoduje, że każdy kolejny skoroszyt zostanie wyświetlony nad poprzednim, jak na Rysunek 1-4.


      Jeśli skoroszyty są już rozmieszczone w sposób najbardziej odpowiadający użytkownikowi, można bez problemu kopiować, wklejać, przeciągać i upuszczać między nimi dane i wykonywać inne operacje.


      Jeśli okaże się, że utworzony widok będzie używany również później, można go zapisać jako obszar roboczy. Aby zapisać obszar roboczy, należy na karcie Widok w grupie Okno wybrać polecenie Zapisz obszar roboczy (w starszych wersjach należy wybrać polecenie Plik→Zapisz obszar roboczy), w oknie dialogowym Zapisywanie obszaru roboczego podać nazwę pliku i kliknąć OK. Plik zawierający obszar roboczy będzie miał rozszerzenie .xlw zamiast standardowego rozszerzenia Excela 2007 .xlsx. Aby z powrotem wyświetlić wybrany skoroszyt obszaru roboczego na pełnym ekranie, wystarczy kliknąć dwukrotnie myszą na pasku tytułu okna tego skoroszytu (w przypadku komputerów Mac trzeba kliknąć zielony przycisk powiększenia znajdujący się w lewym górnym rogu okna). Można również kliknąć przycisk Maksymalizuj dowolnego okna skoroszytu obszaru roboczego. Po zakończeniu pracy należy zamknąć skoroszyty w standardowy sposób.


      
        

        [image: Cztery skoroszyty rozmieszczone sąsiadująco]


        Rysunek 1-1. Cztery skoroszyty rozmieszczone sąsiadująco

      


      
        

        [image: Cztery skoroszyty rozmieszczone poziomo]


        Rysunek 1-2. Cztery skoroszyty rozmieszczone poziomo

      


      
        

        [image: Cztery skoroszyty rozmieszczone pionowo]


        Rysunek 1-3. Cztery skoroszyty rozmieszczone pionowo

      


      
        

        [image: Cztery skoroszyty rozmieszczone kaskadowo]


        Rysunek 1-4. Cztery skoroszyty rozmieszczone kaskadowo

      


      Gdy tylko ponownie zajdzie potrzeba otwarcia tego samego zbioru skoroszytów, wystarczy po prostu otworzyć plik .xlw — wyświetlone zostaną wówczas wszystkie skoroszyty rozmieszczone w taki sposób, jaki zdefiniowano na początku. Jeśli trzeba będzie otworzyć tylko jeden z tych skoroszytów, wystarczy otworzyć jego plik w standardowy sposób. Dowolne zmiany wprowadzone w skoroszytach zapisanych w pliku .xlw zostaną zapisane automatycznie w momencie zamknięcia całego obszaru roboczego, każdy z tych skoroszytów można również zapisywać pojedynczo.


      Jeśli poświęci się chwilę czasu na utworzenie własnych widoków odpowiednich do wykonywania powtarzalnych zadań, wymagających pracy na kilku otwartych skoroszytach jednocześnie, szybko okaże się, że zadania te łatwiej jest wykonywać. Dla często wykonywanych zadań można utworzyć różne widoki, zależnie od charakteru zadania lub własnego upodobania.

    


    
      
        Sposób 2. Wszystkie Wpisywanie danych w kilku arkuszach jednocześnie

      


      
        

        [image: image with no caption]

      


      
        
          Często pożądane jest, by te same dane znajdowały się jednocześnie w kilku arkuszach. W tym celu można skorzystać z grupowania dostępnego w Excelu, dzięki któremu w tym samym czasie w skoroszycie można wpisywać dane jednocześnie do kilku różnych arkuszy. Przedstawimy również rozwiązanie szybsze i bardziej elastyczne, które będzie bazowało na kilku wierszach kodu Visual Basic for Applications (VBA).

        

      


      Wbudowany mechanizm Excela odpowiedzialny za umożliwienie wpisywania danych jednocześnie w kilku różnych miejscach to tak zwane grupowanie. Jego działanie polega na grupowaniu arkuszy w taki sposób, by w ramach jednego skoroszytu były one ze sobą wzajemnie połączone.


      
        
          Ręczne grupowanie arkuszy

        


        Aby wykonać ręczne grupowanie arkuszy, należy kliknąć arkusz, w którym będą wpisywane dane, a następnie, trzymając wciśnięty klawisz Ctrl (lub [image: ] w komputerach Macintosh), klikać po kolei zakładki nazw arkuszy, w których te dane mają się znaleźć. Gdy w dowolnej komórce arkusza wpisane zostaną jakieś dane, znajdą się one również we wszystkich pozostałych zgrupowanych arkuszach. Zadanie zostanie tym samym wykonane.


        Aby rozgrupować arkusze, należy wybrać jeden z arkuszy, który nie jest częścią grupy, albo kliknąć prawym przyciskiem myszy na dowolnej zakładce nazwy któregoś z arkuszy i w menu podręcznym wybrać polecenie Rozgrupuj arkusze lub też nacisnąć klawisz Ctrl/[image: ] i klikać arkusze dodane do grupy.


        
          


          Ostrzeżenie


          Gdy arkusze są zgrupowane, na pasku tytułu skoroszytu wyświetlone jest słowo Grupa umieszczone w nawiasach kwadratowych. Dzięki temu wiadomo, że skoroszyty są cały czas pogrupowane. Jeśli jednak użytkownik nie ma orlego wzroku i umysłu ostrego jak brzytwa, to jest bardzo prawdopodobne, że tego słowa nie zauważy albo zapomni, że wcześniej dokonane zostało grupowanie arkuszy. Dlatego gorąco zachęcamy, by rozgrupowywać arkusze od razu po zakończeniu pracy z nimi.

          

        


        Metoda ta jest bardzo prosta, lecz stosując ją, trzeba pamiętać o grupowaniu i rozgrupowywaniu arkuszy w odpowiednim momencie, w przeciwnym bowiem razie można nieodwracalnie nadpisać dane znajdujące się w innym arkuszu. Można na przykład zechcieć, by wpisywanie danych jednocześnie do kilku arkuszy odbywało się tylko wówczas, gdy będą one wprowadzane do komórek z konkretnego zakresu.

      


      
        
          Automatyczne grupowanie arkuszy

        


        Wspomnianych niedogodności można uniknąć, używając bardzo prostego kodu VBA. Aby kod ten zadziałał, musi się on znaleźć w module prywatnym obiektu Sheet. Aby od razu przejść do modułu prywatnego, należy kliknąć prawym przyciskiem myszy na zakładce nazwy arkusza i wybrać polecenie Wyświetl kod. W module prywatnym obiektu Sheet można wówczas użyć jednego ze zdarzeń arkuszy Excela, którego zaistnienie spowoduje wykonanie kodu. Zdarzenia te mogą polegać na przykład na zmianie komórki, zaznaczeniu zakresu, uaktywnieniu lub dezaktywowaniu arkusza i tak dalej.


        
          


          Podpowiedź


          W większości przypadków po kliknięciu prawym przyciskiem myszy na arkuszu lub skoroszycie i wybraniu polecenia Wyświetl kod Excel automatycznie przeniesie użytkownika do prywatnego modułu. Aby upewnić się, że to w istocie prywatny moduł, należy sprawdzić stan listy rozwijanej w dół umieszczonej w górnym lewym rogu okna z kodem, które zazwyczaj nazwane jest mniej więcej w następujący sposób: Zeszyt — nazwa_arkusza (Code). Jeżeli w liście rozwijanej w dół pokazana jest opcja Workbook lub Worksheet, oznacza to, że użytkownik znajduje się w prywatnym module. Jeżeli opcją jest General, to należy ją zmienić przed rozpoczęciem wprowadzania kodu.

          

        


        Pierwszą czynnością, którą należy wykonać w celu uruchomienia grupowania, jest nadanie nazwy zakresowi komórek, które mają zostać zgrupowane, aby wpisywane dane automatycznie pojawiły się również w innych arkuszach.


        W module prywatnym należy wpisać następujący kod:

        Private Sub Worksheet_SelectionChange(ByVal Target As Excel.Range)
  If Not Intersect(Range("MójZakres"), Target) Is Nothing Then
    'Celowo na pierwszym miejscu znajduje się Arkusz5
    'Będzie to arkusz aktywny, na którym będziemy pracować
      Sheets(Array("Arkusz5", "Arkusz3", "Arkusz1")).Select
  Else
    Me.Select
  End If
End Sub


        W powyższym kodzie użyliśmy zakresu o nazwie MójZakres. (Jeśli temat zakresów nazwanych nie był dotąd Czytelnikowi znany, można zapoznać się z tematem „Sposób 44. Wszystkie Odwoływanie się do danych przy użyciu nazwy”.) Nazwę MójZakres należy zamienić na nazwę używaną we własnym arkuszu. Zmienić trzeba również nazwy trzech arkuszy w kodzie źródłowym, widocznym na Rysunek 1-5, na nazwy arkuszy, które mają zostać zgrupowane. Po wykonaniu tych czynności można zamknąć okno modułu lub nacisnąć Alt/[image: ]+Q, aby powrócić do Excela, a następnie zapisać swój arkusz.


        Trzeba zaznaczyć, iż pierwszym arkuszem użytym w tablicy musi być arkusz, w którym zapisany jest kod źródłowy, czyli inaczej mówiąc, arkusz, w którym będą wpisywane dane.


        Gdy kod znajdzie się już w odpowiednim miejscu, to za każdym razem, gdy zaznaczona zostanie któraś z komórek na arkuszu, kod sprawdzi, czy komórka ta (Target) należy do zakresu MójZakres. Jeśli tak, kod automatycznie przeprowadzi grupowanie wskazanych arkuszy. Jeśli komórka nie będzie należeć do zakresu, arkusze zostaną rozgrupowane poprzez uaktywnienie arkusza bieżącego. Cały urok tego sposobu polega na tym, że nie trzeba ręcznie grupować arkuszy i narażać się tym samym na ryzyko, że zapomni się je potem rozgrupować. Sposób ten pozwoli zaoszczędzić mnóstwo czasu i nerwów.


        
          

          [image: Kod źródłowy automatycznie wykonujący grupowanie arkuszy]


          Rysunek 1-5. Kod źródłowy automatycznie wykonujący grupowanie arkuszy

        


        Jeśli pożądane jest, by te same dane pojawiły się od razu w innych arkuszach, ale nie w komórkach o tych samych adresach, należy wpisać poniższy kod:

        Private Sub Worksheet_SelectionChange(ByVal Target As Excel.Range)
  If Not Intersect(Range("MójZakres"), Target) Is Nothing Then
    With Range("MójZakres")
    .Copy Destination:=Sheets("Arkusz3").Range("A1")
    .Copy Destination:=Sheets("Arkusz1").Range("D10")
    End With
  End If
End Sub


        Ten kod również musi się znaleźć w module prywatnym obiektu Sheet. Aby go tam umieścić, trzeba wykonać czynności opisane wcześniej.

      

    


    
      
        Sposób 3. Wszystkie Uniemożliwianie użytkownikom wykonywania określonych czynności
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          Excel umożliwia wprawdzie zabezpieczenie całych skoroszytów i arkuszy, lecz to niezbyt elastyczne narzędzie, gdyż nie pozwala na ograniczenie uprawnień użytkowników. Na szczęście jest na to sposób.

        

      


      Monitorując zdarzenia i w razie potrzeby reagując na nie, można zarządzać działaniami wykonywanymi przez użytkowników w arkuszach. Zdarzenie, jak sama nazwa wskazuje, to czynność wykonywana w trakcie pracy z arkuszami lub skoroszytami. Wśród zdarzeń podstawowych wymienić można otwarcie skoroszytu, zapisanie go i zamknięcie po zakończeniu w nim pracy. Można nakazać Excelowi, by w momencie zaistnienia któregoś z tych zdarzeń automatycznie wykonał określony kod Visual Basic for Applications.


      
        


        Ostrzeżenie


        Użytkownicy mogą obejść zdefiniowane zabezpieczenia, całkowicie wyłączając obsługę makr. W tym celu należy kliknąć Przycisk Office i wybrać Opcje programu Excel→Centrum zaufania→Ustawienia Centrum zaufania...→Ustawienia makr (w wersjach wcześniejszych: Narzędzia→Makra→Bezpieczeństwo). Jeżeli bezpieczeństwo makr ustawione jest na opcję Wyłącz wszystkie makra i wyświetl powiadomienie (w wersjach wcześniejszych jest to poziom Średni), użytkownik będzie powiadamiany o wszystkich makrach w arkuszu podczas jego otwierania i będzie miał możliwość ich wyłączenia. Opcja Wyłącz wszystkie makra bez powiadomienia (poziom Wysoki w starszych wersjach) po prostu automatycznie je wyłączy. Z drugiej jednak strony, jeżeli korzystanie z arkusza wymaga używania makr, użytkownicy mogą woleć, aby makra były włączone. Sztuczki te są wygodne i nie zapewniają silnego zabezpieczenia danych. Na komputerach z systemem Mac OS X użytkownik nie ma aż tak szczegółowej kontroli nad stopniem ochrony makr. Zamiast tego może wybrać Excel→Preferences→Security, a następnie włączyć ustawienie Warn before opening a file that contains macros.

        

      


      
        
          Blokowanie w arkuszu polecenia Zapisz jako...

        


        Można wskazać, by każdy skoroszyt był zapisywany jako „tylko do odczytu” — w tym celu należy zaznaczyć pole wyboru Zalecane tylko do odczytu w oknie dialogowym Opcje zapisywania, wywoływanym z poziomu okna aktywowanego poleceniem Przycisk Office→Zapisz jako→Narzędzia→Opcje ogólne... (we wcześniejszych wersjach wywoływane za pomocą polecenia Plik→Zapisz jako→Narzędzia [Options na komputerach Mac] →Opcje ogólne...). Dzięki temu użytkownik nie będzie mógł zapisać zmian wprowadzonych w pliku, chyba że zapisze go pod inną nazwą i (lub) w innej lokalizacji.


        Czasami jednak trzeba uniemożliwić użytkownikowi nawet zapisywanie skoroszytu w innym katalogu lub folderze pod tą samą albo inną nazwą. Inaczej mówiąc, może zaistnieć potrzeba, by użytkownik zapisywał zmiany jedynie w oryginalnym pliku, a nie w jego kopii znajdującej się w innym miejscu. Możliwość taka okaże się szczególnie przydatna wówczas, gdy zmiany w skoroszycie będzie wprowadzać kilka osób — uniknie się w ten sposób sytuacji, w której w różnych folderach znajdować się będą różne kopie tego samego skoroszytu.


        Zdarzenie BeforeSave, które wykorzystamy, jest dostępne w Excelu, począwszy od wersji 97. Pojawia się ono tuż przed zapisaniem skoroszytu i umożliwia powstrzymanie działania użytkownika, wyświetlenie ostrzeżenia i zapobieżenie zapisania skoroszytu przez program.


        
          


          Ostrzeżenie


          Przed wypróbowaniem przedstawionego sposobu trzeba najpierw zapisać skoroszyt. Jeśli nie zostanie on zapisany i umieści się w nim kod źródłowy, nie będzie już możliwości zapisania pliku.

          

        


        Aby wstawić kod źródłowy, należy otworzyć skoroszyt i wybrać kartę Deweloper→Visual Basic, a następnie wybrać polecenie View→Code i dwukrotnie kliknąć myszą pozycję This-Workbook znajdującą się w Eksploratorze projektu (we wcześniejszych wersjach trzeba kliknąć prawym przyciskiem myszy ikonę Excela znajdującą się na lewo od pozycji Plik na pasku menu arkusza i wybrać polecenie Wyświetl kod, jak ilustruje to Rysunek 1-6).


        
          

          [image: Menu szybkiego dostępu (w Excelu 2003) do prywatnego modułu obiektu skoroszytu]


          Rysunek 1-6. Menu szybkiego dostępu (w Excelu 2003) do prywatnego modułu obiektu skoroszytu

        


        
          


          Podpowiedź


          Może zajść konieczność włączenia karty Deweloper (nie jest ona standardową wstążką programu Excel 2007) poprzez wybranie Przycisk Office→Opcje programu Excel→Popularne, zaznaczenie opcji Pokaż kartę Deweloper na wstążce i kliknięcie przycisku OK.

          

        


        
          


          Podpowiedź


          Na komputerach Mac skrót ten nie jest dostępny. Będzie trzeba otworzyć edytor Visual Basic Editor (VBE), naciskając klawisze Option+F11 lub wybierając polecenie Tools→Macro→Visual Basic Editor. Po uruchomieniu edytora w oknie Projects należy kliknąć pozycję This Workbook prawym przyciskiem myszy lub przyciskiem lewym, przytrzymując wciśnięty klawisz Ctrl.

          

        


        W dalszej kolejności należy wpisać poniższy kod w VBE, jak pokazano na Rysunek 1-7, oraz nacisnąć klawisze Alt/[image: ]+Q, aby powrócić do Excela, a następnie zapisać arkusz.

        Private Sub Workbook_BeforeSave(ByVal SaveAsUI As Boolean, Cancel As Boolean)
Dim lReply As Long
  If SaveAsUI = True Then
    lReply = MsgBox("Nie można zapisać tego skoroszytu pod inną nazwą. " _
                   &  "Czy zapisać skoroszyt?", vbQuestion + vbOKCancel)
    Cancel = (lReply = vbCancel)
  If Cancel = False Then Me.Save
    Cancel = True
  End If
End Sub


        
          

          [image: Kod źródłowy po wpisaniu go w module prywatnym obiektu ThisWorkbook]


          Rysunek 1-7. Kod źródłowy po wpisaniu go w module prywatnym obiektu ThisWorkbook

        


        Proponujemy wypróbować ten sposób. Należy kliknąć Przycisk Office→Zapisz (w wersjach wcześniejszych Plik→Zapisz) — skoroszyt zostanie zapisany w zwykły sposób. Jeśli jednak wybrane zostanie polecenie Przycisk Office→Zapisz jako (w starszych wersjach Plik→Zapisz jako...), na ekranie pojawi się informacja, że nie można zapisać skoroszytu pod inną nazwą, chyba że makra zostały wyłączone.


        
          


          Podpowiedź


          Należy zauważyć, że w Excelu 2007 podczas zapisywania skoroszytu zawierającego makra lub kod VBA użytkownik poproszony zostanie o zapisanie skoroszytu w formacie skoroszytu programu Excel z obsługą makr (*.xlsm) i nie będzie mógł zapisać go w standardowym pliku Excela (*.xlsx).

          

        

      


      
        
          Uniemożliwianie użytkownikom drukowania skoroszytu

        


        Być może trzeba będzie zapobiec drukowaniu skoroszytu przez użytkownika, aby uniknąć wyrzucenia wydruku do kosza czy pozostawienia go na biurku w widocznym miejscu. Można do tego użyć zdarzenia BeforePrint. W edytorze VBE należy wpisać poniższy kod tak jak przedtem:

        Private Sub Workbook_BeforePrint(Cancel As Boolean)
  Cancel = True
  MsgBox "Nie można wydrukować tego skoroszytu", vbInformation
End Sub


        Gdy powyższy kod zostanie wpisany, należy nacisnąć Alt/[image: ]+Q, aby go zapisać i powrócić do Excela. Od teraz, gdy użytkownik spróbuje wydrukować skoroszyt, ani razu mu się to nie uda. Instrukcja MsgBox jest opcjonalna, lecz zawsze lepiej jest za jej pomocą wyświetlić użytkownikowi odpowiednią informację, by nie dzwonił niepotrzebnie do działu IT swojej firmy i nie zgłaszał problemu z arkuszem.


        Jeśli zablokować trzeba możliwość drukowania jedynie wybranych arkuszy skoroszytu, można użyć nieco zmodyfikowanego kodu:

        Private Sub Workbook_BeforePrint(Cancel As Boolean)
  Select Case ActiveSheet.Name
    Case "Arkusz1", "Arkusz2"
      Cancel = True
      MsgBox "Nie można wydrukować tego arkusza", vbInformation
    End Select
End Sub


        Zwróćmy uwagę, że w kodzie tym wskazano jedynie Arkusz1 i Arkusz2 jako te, których nie można drukować. Oczywiście w ich miejsce można wpisać nazwy dowolnych arkuszy znajdujących się w skoroszycie, a także dopisać do tej listy dodatkowe arkusze, wpisując ich nazwy w cudzysłowie i poprzedzając je przecinkami. Jeśli trzeba uniemożliwić drukowanie tylko jednego arkusza, wystarczy wpisać jego nazwę i nie wpisywać już znaku przecinka.

      


      
        
          Uniemożliwianie użytkownikom wstawiania dodatkowych arkuszy

        


        Excel potrafi chronić strukturę skoroszytu, tak by użytkownicy nie mogli usuwać arkuszy, zmieniać kolejności, w jakiej są wyświetlane, zmieniać ich nazw i tak dalej. Czasami jednak konieczne jest zablokowanie możliwości wstawiania dodatkowych arkuszy bez blokowania innych zmian w strukturze skoroszytu.


        Zadanie to spełni poniższy kod źródłowy:

        Private Sub Workbook_NewSheet(ByVal Sh As Object)
  Application.DisplayAlerts = False
    MsgBox "Nie można dodawać nowych arkuszy do tego skoroszytu",
vbInformation
    Sh.Delete
  Application.DisplayAlerts = True
End Sub


        Powyższy kod źródłowy najpierw powoduje wyświetlenie okna komunikatu z odpowiednią informacją, a gdy użytkownik kliknie w tym oknie przycisk OK, kod natychmiast usunie dopiero co wstawiony nowy arkusz. Instrukcja Application.DisplayAlerts = False blokuje wyświetlenie przez Excel standardowego ostrzeżenia z pytaniem, czy użytkownik rzeczywiście chce usunąć arkusz. Po wpisaniu tego kodu użytkownicy nie będą mieli możliwości dodawania do skoroszytu nowych arkuszy.


        Istnieje również inny sposób zapobiegania wstawianiu nowych arkuszy przez użytkowników. W tym celu należy wybrać polecenie Recenzja→Chroń skoroszyt, a następnie zaznaczyć opcje Struktura i Okna (w wersjach wcześniejszych należy wybrać polecenie Narzędzia→Ochrona→Chroń skoroszyt... i zaznaczyć pole wyboru Struktura, po czym kliknąć OK). Jak już jednak wspomnieliśmy na początku opisu tego sposobu, mechanizm ochrony istniejący w Excelu jest stosunkowo mało elastyczny i będzie uniemożliwiał korzystanie również z innych narzędzi arkusza kalkulacyjnego.

      

    


    
      
        Sposób 4. Wszystkie Zapobieganie wyświetlaniu niepotrzebnych komunikatów
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          Czasami Excel okazuje się nadgorliwy i wyświetla komunikaty z prośbą o potwierdzenie wykonania operacji, o które dopiero co go poproszono. Najlepiej jest zakończyć tę wymianę zdań i nakazać Excelowi powrót do pracy.

        

      


      Mamy tu na myśli komunikaty z pytaniem, czy mają zostać włączone makra (choć ich nie ma), albo czy użytkownik jest pewien, że chce usunąć arkusz. Poniżej przedstawiamy sposoby pozbycia się tych komunikatów raz na zawsze.


      
        
          Włączanie makr, gdy ich nie ma

        


        Excel okazuje się mieć bardzo dobrą pamięć zwłaszcza wówczas, gdy zapamiętuje, że w skoroszycie nagrane zostało jakieś makro. Niestety, program będzie o tym pamiętał nawet wtedy, gdy jedno lub więcej makr zostanie usunięte za pomocą polecenia Deweloper→Makra (w starszych wersjach Narzędzia→Makro→Makra...) lub kombinacji klawiszy Alt/Option+F8. Gdy potem ponownie otworzy się skoroszyt, Excel znowu zapyta, czy włączyć makra, pomimo że żadne w tym skoroszycie już nie istnieje.


        
          


          Podpowiedź


          Komunikat z pytaniem o włączenie makr będzie wyświetlany tylko wówczas, gdy poziom zabezpieczeń zostanie ustawiony na Wyłącz wszystkie makra i włącz powiadomienia (w starszych wersjach poziom Średni). Jeśli poziom zostanie ustawiony na Włącz wszystkie makra (w starszych wersjach Niski), makra będą włączane bez pytania, natomiast jeśli poziom ten będzie ustawiony na Wyłącz wszystkie makra bez powiadamiania (w starszych wersjach Wysoki), makra zostaną automatycznie zablokowane, aby ochronić przed nimi użytkownika.

          

        


        Gdy nagrywane jest makro, Excel wstawia moduł Visual Basica, w którym zostaną zapisane wszystkie wydane przez użytkownika polecenia i napisane przez niego samodzielnie funkcje. W momencie otwierania skoroszytu Excel sprawdza, czy taki moduł istnieje i czy jest pusty, czy też zawiera jakieś makra. Usunięcie makr ze skoroszytu spowoduje usunięcie również całego kodu znajdującego się w module, ale nie samego modułu — trochę przypomina to wypicie mleka i wstawienie pustego kartonika z powrotem do lodówki. Aby uniknąć niepotrzebnych pytań o włączanie makr, trzeba usunąć moduł. Oto jak można tego dokonać.


        Należy otworzyć VBE za pomocą polecenia Deweloper→Visual Basic znajdującego się w grupie Kod (w starszych wersjach należy wybrać polecenie Narzędzia→Makro→Visual Basic Editor, a następnie View→Project Explorer) lub naciskając Alt/Option+F11.


        
          


          Podpowiedź


          Na komputerach Macintosh okno Projects jest zawsze otwarte, nie trzeba więc go ponownie otwierać.

          

        


        Na ekranie pojawi się okno podobne do widocznego na Rysunek 1-8.
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          Rysunek 1-8. Moduły Project Explorer z rozwiniętym folderem Modules

        


        W oknie Project Explorer trzeba odszukać swój skoroszyt i kliknąć po jego lewej stronie znak plus (+), aby wyświetlić jego komponenty — w tym również moduły. Gdy kliknięty zostanie znak plus znajdujący się z lewej strony folderu Modules, wyświetlone zostaną wszystkie znajdujące się w skoroszycie moduły.


        Po kolei należy klikać prawym przyciskiem myszy każdy moduł i z menu podręcznego wybierać polecenie Remove Module. Nie należy zgadzać się również na eksport modułów. Aby przypadkiem nie usunąć modułów, które zawierają użyteczny kod, należy kliknąć dwukrotnie każdy z nich po kolei i upewnić się, że rzeczywiście nie są już potrzebne. Na końcu, jak zwykle, naciskamy Alt/[image: ]+Q, aby powrócić do widoku arkusza w Excelu.

      


      
        
          Pytanie o zapisanie nieistniejących zmian

        


        Być może Czytelnik zwrócił uwagę, że czasami wystarczy otworzyć skoroszyt i go przejrzeć, by Excel zapytał, czy ma zapisać zmiany dokonane w osobistym skoroszycie makr, choć przecież żadne zmiany nie zostały wprowadzone. Można o tym wiedzieć lub nie, ale najprawdopodobniej w osobistym skoroszycie makr znajduje się funkcja zmienna.


        Osobisty skoroszyt makr to ukryty skoroszyt, tworzony w momencie rejestrowania makra po raz pierwszy (Narzędzia→Makro→Zarejestruj nowe makro) i wybrania opcji Osobisty skoroszyt makr z listy rozwijanej Zapisz makro w. Otwierany jest on za każdym razem, gdy otwierany jest Excel. Funkcja zmienna (lub formuła zmienna) to taka funkcja, która jest przeliczana na nowo w momencie wykonywania niemal każdej operacji, w tym otwierania i zamykania skoroszytu lub całego programu. Dwie najczęściej spotykane funkcje zmienne to Today() oraz Now().


        Zatem nawet jeśli użytkownik jest przekonany, że sam nie wprowadził żadnych zmian w skoroszycie, zmian takich mogły dokonać funkcje zmienne wywołane w tle. Ich działanie jest traktowane jako zmiany i dlatego Excel pyta o zapisanie zmian niewidocznych gołym okiem.


        Można skorzystać z kilku sposobów, aby Excel przestał pytać użytkownika o zapisanie zmian, których użytkownik sam nie dokonał. Najbardziej oczywisty polega na tym, by przede wszystkim nie zapisywać żadnych funkcji zmiennych w osobistym folderze makr oraz by usunąć wszystkie tego typu funkcje, które już się w nim znajdują. A jeśli funkcje te okażą się potrzebne, można wykorzystać poniższy fragment prostego kodu, aby wyprowadzić Excela w pole, tak by „wydawało mu się”, że osobisty arkusz makr został zapisany w momencie otwarcia:

        Private Sub Workbook_BeforeClose(Cancel As Boolean)
  Me.Saved = True
End Sub


        Kod ten musi się znaleźć w prywatnym module osobistego skoroszytu makr. Aby go otworzyć z poziomu dowolnego skoroszytu, należy wybrać polecenie Widok→Odkryj (w starszych wersjach Okno→Odkryj), w oknie Odkryj skoroszyt wybrać Personal.xls i kliknąć OK. Następnie trzeba przejść do VBE i wpisać wspomniany wcześniej kod. Gdy wszystkie te czynności zostaną wykonane, należy nacisnąć Alt/[image: ]+Q, aby powrócić do Excela.


        Oczywiście jeśli w arkuszu znajdują się funkcje zmienne, które powinny zostać przeliczone i których wyniki powinny zostać zapisane, trzeba jawnie nakazać Excelowi wykonanie odpowiedniej czynności:

        Private Sub Workbook_BeforeClose(Cancel As Boolean)
  Me.Save
End Sub


        Makro to automatycznie zapisze osobisty skoroszyt makr za każdym razem, gdy zostanie otwarte.

      


      
        
          Wyłączanie ostrzeżeń wyświetlanych w trakcie wykonywania nagranych makr

        


        Jedną z głównych wad nagranych makr jest to, że choć doskonale zastępują one niemal każde polecenie, to często nie zapamiętują odpowiedzi udzielonych na pytania zadawane przez Excela. Gdy użytkownik będzie chciał usunąć arkusz, Excel poprosi go o potwierdzenie tej operacji, a gdy tę samą czynność użytkownik będzie chciał wykonać przy użyciu makra — znów będzie trzeba ją potwierdzić. Wyłączmy zatem te komunikaty.


        Najpierw należy wyświetlić listę makr za pomocą polecenia Deweloper→Makra z grupy Kod lub kombinacji klawiszy Alt/Option+F8 (w wersjach wcześniejszych za pomocą polecenia Narzędzia→Makro→Makra...). Trzeba upewnić się, że na liście rozwijanej Makra w: wybrana jest wartość Wszystkie otwarte skoroszyty. Następnie należy wybrać odpowiednie makro i kliknąć przycisk Edycja. W dalszej kolejności trzeba umieścić kursor w pierwszym wierszu kodu — to znaczy w pierwszym wierszu, który nie rozpoczyna się od znaku apostrofu — i wpisać następujący wiersz:

        Application.DisplayAlerts = False


        Na samym końcu kodu należy wpisać następujący wiersz:

        Application.DisplayAlerts = True


        Makro powinno mieć mniej więcej taką postać:

        Sub MojeMakro()
'
' Makro MojeMakro
' Usuwa aktywny arkusz
'

'
  Application.DisplayAlerts = False
  ActiveSheet.Delete
  Application.DisplayAlerts = True
End Sub


        Zwróćmy uwagę, że na końcu makra z powrotem włączane jest wyświetlanie komunikatów, aby umożliwić Excelowi ich prezentowanie w trakcie pracy z arkuszem kalkulacyjnym. Jeśli instrukcja ta nie zostanie zamieszczona, nie będą wyświetlane żadne komunikaty — nawet te, o których użytkownik powinien wiedzieć.


        
          


          Ostrzeżenie


          Jeśli z jakiegoś powodu — na przykład wystąpienia błędu fazy wykonania — makro nie zostanie całkowicie zrealizowane, Excel może nie dotrzeć do wiersza kodu odpowiedzialnego za włączenie wyświetlania komunikatów. W takiej sytuacji chyba najlepszym rozwiązaniem będzie ponowne uruchomienie Excela, aby ponownie pracował on w standardowy sposób.

          

        


        Wiemy już zatem, jak wyłączać wyświetlanie komunikatów przez Excela. Trzeba jednak pamiętać, że są one wyświetlane z konkretnych powodów, dlatego zanim wyłączy się dany komunikat, trzeba najpierw dokładnie rozpoznać przyczynę, dla której jest on generowany.

      

    


    
      
        Sposób 5. Wszystkie Ukrywanie arkuszy w taki sposób, by nie można było ich odkryć

      


      
        

        [image: image with no caption]

      


      
        
          Czasami trzeba zamieścić w skoroszycie informacje, których użytkownicy nie powinni widzieć ani modyfikować. Utwórzmy więc arkusz stanowiący zaplecze skoroszytu i umieśćmy w nim dane, formuły i inne informacje wykorzystywane w arkuszu, lecz niewidoczne w nim.

        

      


      Gdy tworzony jest nowy skoroszyt Excela, warto zarezerwować sobie jeden arkusz na informacje, których użytkownik nie musi widzieć: obliczenia wyników formuł, weryfikację danych, listy, przydatne zmienne i wartości specjalne, dane zastrzeżone i tak dalej. Można co prawda ukryć arkusz za pomocą polecenia Widok→Ukryj (w starszych wersjach Format→Arkusz→Ukryj), lecz użytkownik zawsze będzie mógł go odkryć, wydając polecenie Widok→Odkryj (w starszych wersjach Format→Arkusz→Odkryj...).


      Można oczywiście włączyć ochronę arkusza, lecz wówczas wszystkie jego elementy — dane zastrzeżone, formuły i tak dalej — będą nadal widoczne. Nie będzie można poza tym w żaden sposób ochronić komórki podłączonej do kontrolek udostępnianych na pasku narzędzi Formularze.


      Możemy wykorzystać właściwość Visible arkusza, a konkretnie ustawić jej wartość na xlSheetVeryHidden. Trzeba wybrać polecenie Deweloper→Visual Basic lub nacisnąć klawisze Alt/Option+F11 (w starszych wersjach Narzędzia→Makro→Edytor Visual Basic), aby przejść do edytora VBE, a następnie należy wybrać polecenie View→Project Explorer, aby wyświetlić okno eksploratora projektu. Trzeba odszukać w nim nazwę skoroszytu i kliknąć znak + po lewej stronie, aby rozwinąć jego hierarchię. Następnie należy rozwinąć znajdujący się w niej folder Microsoft Excel Objects, aby wyświetlić wszystkie arkusze znajdujące się w skoroszycie.


      W oknie Project Explorer należy zaznaczyć arkusz, który ma być ukryty, i wyświetlić jego właściwości, wybierając polecenie View→Properties Window (lub naciskając klawisz F4). Należy upewnić się, że wybrana jest zakładka Alphabetic i przejść do właściwości Visible znajdującej się na samym jej dole, po czym kliknąć strzałkę znajdującą się po prawej stronie pola wartości tej właściwości i na liście rozwijanej wskazać ostatnią opcję: 2 – xlSheetVeryHidden, co pokazano na Rysunek 1-9. Na koniec należy nacisnąć Alt/[image: ]+Q, aby zapisać zmiany i powrócić do Excela. Od teraz arkusz nie będzie już widoczny w Excelu ani nie będzie go można odkryć, wydając polecenie Widok→Odkryj (w starszych wersjach Format→Arkusz→Odkryj...).


      
        


        Ostrzeżenie


        Po wskazaniu w oknie Properties wartości 2 – xlSheetVeryHidden można odnieść wrażenie, że nie przyniosło to żadnego efektu. Jest to jednak błąd związany z wyświetlaniem i nie trzeba się nim martwić. Jeśli arkusz nie jest widoczny na liście Widok→Odkryj (w starszych wersjach Format→Arkusz→Odkryj...), oznacza to, że zamierzony cel został osiągnięty.

        

      


      Aby przywrócić poprzednie ustawienia, trzeba wykonać te same czynności i właściwości Visible nadać wartość –1 – xlSheetVisible.


      
        

        [image: Okno właściwości Properties arkusza z właściwością Visible ustawioną na 2 — xlSheetVeryHidden]


        Rysunek 1-9. Okno właściwości Properties arkusza z właściwością Visible ustawioną na 2 — xlSheetVeryHidden

      

    


    
      
        Sposób 6. Wszystkie Dostosowywanie okna dialogowego Szablony i skoroszytu domyślnego
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          Jeśli często wykonuje się te same zadania lub używa się skoroszytów o takiej samej strukturze, można utworzyć własną zakładkę Moje szablony w oknie dialogowym Excela Szablony, aby ułatwić sobie życie.

        

      


      Wyobraźmy sobie, że mamy arkusz zawierający dni roku oraz formuły podsumowujące różnorodne dane dla tych dni. Efektownie go sformatowaliśmy reprezentacyjnymi kolorami naszej firmy, umieściliśmy jej logo oraz wszystkie potrzebne formuły i chcemy używać go na co dzień. Zamiast codziennie na nowo wynajdywać koło (albo kopiować i usuwać te elementy, których nie potrzebujesz), można oszczędzić sporo cennego czasu i kłopotów, tworząc szablon.


      Szablony arkuszy i skoroszytów Excela stanowią wygodny punkt wyjścia dla kolejnych projektów, ponieważ dzięki nim można uniknąć wykonywania za każdym razem koniecznych czynności wstępnych, formatowania, tworzenia formuł i tak dalej. Zapisanie szablonu arkusza sprowadza się do otwarcia nowego skoroszytu, pozostawienia w nim tylko jednego arkusza i utworzenia w nim podstawowego szablonu, który będzie używany w późniejszym czasie. Po utworzeniu szablonu należy go zapisać, wybierając Przycisk Office→Zapisz jako... (w starszych wersjach polecenie Plik→Zapisz jako...) i wskazując na liście rozwijanej Zapisz jako typ w oknie dialogowym Zapisywanie jako pozycję Szablon program Excel (na komputerach Macintosh — Szablon). Jeśli tworzony szablon ma być szablonem skoroszytu, to znaczy ma on zawierać więcej niż jeden arkusz, trzeba ponownie utworzyć nowy skoroszyt, wprowadzić w nim wszystkie potrzebne zmiany i poprzez wybranie polecenia Przycisk Office→Zapisz jako... (w starszych wersjach Plik→Zapisz jako...) zapisać go jako szablon.


      Po utworzeniu szablonu można w dowolnym momencie utworzyć jego kopię. W tym celu trzeba wybrać polecenie Przycisk Office (w starszych wersjach Plik→Nowy...) i wskazać szablon skoroszytu albo kliknąć prawym przyciskiem myszy na zakładce Arkusz i z menu podręcznego wybrać polecenie Wstaw..., aby wstawić nowy arkusz, utworzony na podstawie szablonu. Czyż nie byłoby jednak wygodniej, gdyby szablony te były dostępne bezpośrednio w standardowym oknie dialogowym Szablony, albo gdyby ustawić jeden z szablonów jako skoroszyt domyślny? Rozwiązanie takie jest możliwe i polega na utworzeniu własnej zakładki Moje szablony.


      
        


        Ostrzeżenie


        W przedstawianym sposobie zakładamy, że na komputerze zainstalowany jest tylko jeden egzemplarz Excela. Jeśli używanych jest kilka kopii lub wersji Excela, sposób ten może okazać się nieskuteczny.

        

      


      
        
          Tworzenie własnej zakładki Szablon

        


        Jeśli utworzonych zostało kilka szablonów skoroszytów, arkuszy lub obu i są one regularnie wykorzystywane, można zgrupować te szablony w jednym miejscu, aby ułatwić sobie zarządzanie nimi.


        Z poziomu dowolnego skoroszytu należy wybrać polecenie Przycisk Office→Zapisz jako... (w wersjach wcześniejszych Plik→Zapisz jako...), a na liście rozwijanej Zapisz jako typ wskazać pozycję Szablon programu Excel (*.xltx) lub w starszych wersjach Szablon (*.xlt). Domyślnie Excel zapisze szablon w folderze Szablony lub Moje szablony, w którym przechowywane są wszystkie szablony, które utworzył użytkownik.


        Jeśli na komputerze nie ma jeszcze folderu Moje szablony, należy utworzyć go jako podfolder folderu Szablony, klikając w tym celu przycisk Nowy folder.


        
          


          Podpowiedź


          Na komputerach z systemem Mac Os X Excel 2004 domyślnie przenosi użytkownika do folderu Moje szablony, więc krok ten nie jest konieczny.

          

        


        Na pasku menu arkusza należy wybrać polecenie Przycisk Office→Nowy i kliknąć przycisk opcji Moje szablony... (w Excelu w wersji 2000 i w wersjach wyższych w wyświetlonym oknie dialogowym Nowy skoroszyt wybrać Szablony ogólne; w przypadku starszych wersji należy na pasku menu arkusza wybrać polecenie Plik→Nowy...). W oknie dialogowym, które pojawi się na ekranie, powinna pokazać się utworzona przed chwilą zakładka (na Rysunek 1-10 nosi ona nazwę Moje szablony). Na tej zakładce z kolei powinny być widoczne utworzone szablony skoroszytów i arkuszy, które zostały zapisane w folderze Moje szablony.


        
          


          Podpowiedź


          Jeżeli w Excelu 2007 użytkownik nie utworzy żadnych zakładek, to szablony przechowywane są w grupie Moje szablony na karcie Moje szablony.
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          Rysunek 1-10. Okno dialogowe Szablony

        

      


      
        
          Używanie własnego skoroszytu domyślnego

        


        W momencie uruchomienia Excel domyślnie otwiera pusty skoroszyt o nazwie Zeszyt1, zawierający trzy puste arkusze. Jeśli po każdym uruchomieniu Excela chcemy zaczynać pracę od zera, takie zachowanie programu powinno być w pełni satysfakcjonujące. Ale jeśli Czytelnik ma z nami coś wspólnego, to zapewne ma ulubiony skoroszyt, który woli bardziej od innych. Gdy my otwieramy Excela, zamykamy skoroszyt domyślny i szukamy skoroszytu, który najbardziej nam odpowiada. Niewątpliwie znacznie wygodniej byłoby, gdyby ten ulubiony skoroszyt otwierał się od razu i był gotowy do użycia.


        Aby to osiągnąć, trzeba zapisać swój skoroszyt domyślny (szablon) w folderze XLSTART (zazwyczaj w systemie Windows prowadzi do niego ścieżka C:\Documents and Settings\Właściciel\Dane Aplikacji\Microsoft\Excel\XLSTART, a w systemie Mac OS X ścieżką tą jest Applications/Microsoft Office X/Office/Startup/Excel). Excel automatycznie użyje któregoś ze skoroszytów znajdujących się w tym folderze jako skoroszytu domyślnego.


        
          


          Podpowiedź


          W folderze XLSTART automatycznie w momencie rozpoczęcia nagrywania makra tworzony jest i zapisywany osobisty skoroszyt makr. Skoroszyt ten jest ukryty. Można również wskazać własne skoroszyty ukryte, które mają się otwierać w tle. W tym celu należy otworzyć wybrany skoroszyt, wybrać polecenie Widok→Ukryj umieszczone w grupie Okno (w starszych wersjach Okno→Ukryj), zamknąć Excela i kliknąć przycisk Tak, aby zapisać zmiany w skoroszycie, który właśnie został ukryty. Następnie trzeba przenieść go do folderu XLSTART. Wszystkie skoroszyty, które zostaną ukryte i zapisane w folderze XLSTART, będą otwierane jako skoroszyty ukryte za każdym razem, gdy otwierany będzie Excel.


          Należy jednak zwrócić uwagę, by nie umieszczać w tym folderze zbyt wielu dużych skoroszytów, ponieważ wszystkie one będą otwierane w momencie uruchamiania Excela. Zbyt duża liczba otwartych skoroszytów może poważnie obniżyć wydajność programu.

          

        


        Oczywiście jeśli użytkownik zmieni zdanie i znów zapragnie, by domyślnie otwierany był pusty skoroszyt, wystarczy usunąć odpowiedni skoroszyt lub szablon skoroszytu z folderu XLSTART.

      

    


    
      
        Sposób 7. Wszystkie Tworzenie indeksu arkuszy znajdujących się w skoroszycie
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          Każdy, kto dużo czasu spędził, pracując ze skoroszytem zawierającym znaczną liczbę arkuszy, wie już, jak trudno jest znaleźć konkretny arkusz. Konieczne staje się wówczas stworzenie arkusza stanowiącego indeks wszystkich arkuszy znajdujących się w pliku.

        

      


      Arkusz indeksu umożliwi szybkie i łatwe przemieszczanie się po skoroszycie — jedno kliknięcie myszą spowoduje natychmiastowe wyświetlenie poszukiwanego arkusza. Indeks taki można utworzyć na kilka sposobów: ręcznie, wygenerować go automatycznie przy użyciu odpowiedniego kodu lub stworzyć go w menu kontekstowym.


      
        
          Ręczne tworzenie indeksu arkuszy

        


        Można spróbować utworzyć indeks ręcznie. Utworzony zostałby nowy arkusz, nadano by mu nazwę Indeks lub podobną, wpisano w nim listę nazw wszystkich arkuszy i wydając polecenie Wstawianie→Hiperłącze znajdujące się w grupie poleceń Łącza (w starszych wersjach Wstaw→Hiperłącze...) lub naciskając klawisze Ctrl/[image: ]+K, utworzono by z nich łącza prowadzące do odpowiedniego arkusza. Metoda ta byłaby wystarczająca wówczas, gdyby w skoroszycie znajdowało się kilka arkuszy i nie podlegałyby one częstym zmianom, jednak uaktualnienia indeksu należałoby również wykonywać ręcznie.

      


      
        
          Automatyczne generowanie indeksu arkuszy za pomocą kodu

        


        Alternatywą dla powyższego rozwiązania jest wykorzystanie VBA do automatycznego wygenerowania indeksu. Poniższy kod automatycznie utworzy indeks zawierający łącza do wszystkich arkuszy znajdujących się w skoroszycie. Indeks ten będzie tworzony na nowo za każdym razem, gdy aktywowany będzie arkusz, w którym ten kod się znajdzie.


        Kod źródłowy przedstawiony poniżej należy wpisać w module prywatnym obiektu Sheet. W skoroszycie trzeba wstawić nowy arkusz i nadać mu odpowiednią nazwę, na przykład Indeks. Następnie należy kliknąć prawym przyciskiem myszy zakładkę arkusza indeksu i z menu podręcznego wybrać pozycję Wyświetl kod lub nacisnąć klawisze Alt/Option+F11, po czym wpisać poniższy kod Visual Basic:

        Private Sub Worksheet_Activate()
Dim wSheet As Worksheet
Dim l As Long
l = 1
  With Me
    .Columns(1).ClearContents
    .Cells(1, 1) = "INDEKS"
    .Cells(1, 1).Name = "Indeks"
  End With

  For Each wSheet In Worksheets
    If wSheet.Name <> Me.Name Then
      l = l + 1
      With wSheet
        .Range("A1").Name = "Start" & wSheet.Index
        .Hyperlinks.Add Anchor:=.Range("A1"), Address:="", SubAddress:= _
          "Indeks", TextToDisplay:="Powrót do indeksu"
    End With
      Me.Hyperlinks.Add Anchor:=Me.Cells(l, 1), Address:="", SubAddress:= _
        "Start" & wSheet.Index, TextToDisplay:=wSheet.Name
    End If
  Next wSheet
End Sub


        Następnie należy nacisnąć Alt/[image: ]+Q, aby powrócić do skoroszytu, po czym zapisać zmiany. Przed uruchomieniem kodu trzeba najpierw dezaktywować arkusz (wybrać inny arkusz) i wybrać arkusz indeksu.


        Zwróćmy uwagę, że kod nadaje nazwę (tak jak nadaje się nazwę komórce lub zakresowi komórek w Excelu) komórce A1. Nazwa składa się ze słowa Start i następującej po nim unikatowej liczby całkowitej, reprezentującej numer arkusza w skoroszycie. Gwarantuje to, że w każdym arkuszu komórka A1 ma inną nazwę. Jeśli w używanym arkuszu komórka A1 ma już nadaną nazwę, trzeba zmienić każde jej wystąpienie w kodzie na inną, bardziej odpowiednią — na przykład dowolną nieużywaną komórkę arkusza.


        
          


          Ostrzeżenie


          Należy pamiętać, że jeśli wybrane zostanie polecenie Przycisk Office→Przygotuj→Właściwości→Właściwości zaawansowane (w starszych wersjach Plik→Właściwości→Podsumowanie) i wpisany zostanie jakiś adres URL jako Baza hiperłączy, indeks utworzony w wyniku uruchomienia powyższego kodu najprawdopodobniej nie będzie działał. Baza hiperłączy to ścieżka lub adres URL, który jest umieszczany jako ich baza we wszystkich hiperłączach znajdujących się w bieżącym dokumencie.

          

        

      


      
        
          Odnośnik do indeksu w menu kontekstowym

        


        Trzecim sposobem budowania indeksu jest dodanie odnośnika do listy arkuszy jako pozycji w menu kontekstowym, dzięki czemu dostęp do niego będzie osiągany bezpośrednio po kliknięciu prawym przyciskiem myszy. Łącze to będzie otwierało standardowy pasek poleceń zakładek skoroszytu. Dostęp do tego paska poleceń uzyskuje się poprzez kliknięcie prawym przyciskiem myszy dowolnej strzałki znajdującej się w lewym dolnym rogu każdego arkusza, co przedstawiono na Rysunek 1-11.


        
          

          [image: Pasek poleceń zakładek wyświetlony w wyniku kliknięcia prawym przyciskiem myszy strzałek przewijania arkuszy]


          Rysunek 1-11. Pasek poleceń zakładek wyświetlony w wyniku kliknięcia prawym przyciskiem myszy strzałek przewijania arkuszy

        


        Aby powiązać pasek poleceń zakładek z kliknięciem prawym przyciskiem myszy w dowolnej komórce, w prywatnym module należy wpisać poniższy kod:

        Private Sub Workbook_SheetBeforeRightClick _
  (ByVal Sh As Object, ByVal Target As Range, Cancel As Boolean)
Dim cCont As CommandBarButton
  On Error Resume Next
  Application.CommandBars("Cell").Controls("Indeks arkuszy").Delete
  On Error GoTo 0
    Set cCont = Application.CommandBars("Cell").Controls.Add _
                (Type:=msoControlButton, Temporary:=True)
    With cCont
      .Caption = "Indeks arkuszy"
      .OnAction = "IndexCode"
    End With
End Sub


        Następnie trzeba wstawić moduł standardowy, w którym znajdzie się makro KodIndeksu. Będzie ono wywoływane przez powyższy kod za każdym razem, gdy użytkownik kliknie prawym przyciskiem myszy. Wpisanie poniższego kodu w module standardowym ma kluczowe znaczenie, ponieważ jeśli zostanie on wpisany w tym samym module, w którym znajduje się makro Workbook_SheetBeforeRightClick, Excel nie znajdzie makra o nazwie KodIndeksu.


        Należy wybrać polecenie Insert→Module i wpisać poniższy kod:

        Sub KodIndeksu()
  Application.CommandBars("Workbook Tabs").ShowPopup
End Sub


        Następnie trzeba nacisnąć Alt/[image: ]+Q, aby powrócić do interfejsu Excela.


        Teraz należy kliknąć prawym przyciskiem myszy w dowolnej komórce któregokolwiek arkusza. W menu powinna pojawić się nowa pozycja menu, nosząca nazwę Indeks arkuszy; przeniesie ona użytkownika prosto do listy arkuszy znajdujących się w skoroszycie.

      

    


    
      
        Sposób 8. Wszystkie Ograniczanie zakresu przewijania arkusza

      


      
        

        [image: image with no caption]

      


      
        
          Jeśli użytkownik często przemieszcza się w ramach jednego arkusza lub wpisuje w nim dane, których nie chciałby ujawniać innym użytkownikom, można zdecydować się na ograniczenie widocznego obszaru arkusza tylko do takiego fragmentu, w którym znajdują się najważniejsze dane.

        

      


      Wszystkie arkusze utworzone w Excelu w wersji 2007 mają szerokość 16 384 (256, od A do IV we wcześniejszych wersjach) kolumn oraz długość 1 048 576 (65 536 we wcześniejszych wersjach) wierszy. W większości przypadków w arkuszach tworzonych przez użytkownika wykorzystywana jest tylko niewielka część wszystkich dostępnych komórek. Istnieje jednak możliwość ograniczenia obszaru przewijania arkusza, by widoczna była tylko ta jego część, która zawiera dane przeznaczone dla użytkownika. Poza tym obszarem można wówczas umieścić te dane, do których użytkownik nie powinien mieć dostępu. Ograniczenie obszaru arkusza sprawi również, że stanie się on bardziej przyjazny — nierzadko zdarza się przecież, że gdy w otwartym arkuszu zaznaczona jest na przykład komórka w wierszu numer 50 000, użytkownik od razu dochodzi do wniosku, iż jest on pusty. Obszar arkusza można ograniczyć, ukrywając wiersze i kolumny, określając odpowiedni zakres komórek lub aktywując jedynie używany zakres komórek.


      
        
          Ukrywanie wierszy i kolumn

        


        Najprostszym sposobem na ograniczenie obszaru arkusza jest ukrycie wszystkich nieużywanych kolumn i wierszy. Na utworzonym arkuszu należy w tym celu znaleźć ostatni wiersz, w którym znajdują się dane, i zaznaczyć cały wiersz znajdujący się pod nim, klikając na jego etykiecie. Następnie, trzymając wciśnięte przyciski Ctrl i Shift, należy nacisnąć klawisz strzałki w dół, aby zaznaczyć wszystkie pozostałe wiersze znajdujące się poniżej, po czym wybrać polecenie Narzędzia główne→Format→Ukryj i odkryj→Ukryj wiersze lub kliknąć prawym przyciskiem myszy i wybrać plecenie Ukryj (w wersjach wcześniejszych Format→Wiersz→Ukryj), aby je wszystkie ukryć. Tę samą czynność należy wykonać w odniesieniu do nieużywanych kolumn: znajdujemy ostatnią kolumnę zawierającą dane, zaznaczamy całą kolumnę znajdującą się po jej prawej stronie, naciskamy klawisz strzałki w prawo, trzymając jednocześnie wciśnięte Ctrl i Shift, po czym wybieramy polecenie Narzędzia główne→Format→Ukryj i odkryj→Ukryj kolumny (w wersjach wcześniejszych Format→Kolumna→Ukryj). Jeśli wszystko pójdzie zgodnie z planem, używane komórki arkusza powinny zostać otoczone szarym obszarem, poza który nie można już przewijać ekranu.

      


      
        
          Określenie odpowiedniego zakresu komórek

        


        Drugi sposób ustanowienia ograniczeń polega na wskazaniu odpowiedniego zakresu komórek w oknie Właściwości arkusza. W tym celu trzeba kliknąć prawym przyciskiem myszy na zakładce arkusza znajdującej się w lewym dolnym rogu okna i z menu podręcznego wybrać polecenie Wyświetl kod. Jeżeli używana jest wcześniejsza niż 2007 wersja Excela, w systemie Windows może zajść potrzeba wybrania polecenia View→Project (Ctrl+R), aby wyświetlić okno Project Explorer (na komputerach Macintosh jest ono cały czasy widoczne). Jeśli okno właściwości Properties nie jest widoczne, wciskamy F4. Następnie wybieramy właściwy arkusz i wyświetlamy w oknie Właściwości właściwość ScrollArea.


        W kolejnym kroku w oknie Project Explorer należy zaznaczyć arkusz, którego obszar przewijania ma ulec ograniczeniu, a następnie w oknie Properties (widocznym na Rysunek 1-12) trzeba przejść do właściwości ScrollArea. W znajdującym się po prawej stronie polu wartości należy zdefiniować odpowiednie ograniczenia obszaru arkusza, na przykład jako $A$1:$G$50.


        Przewijanie poza wskazany obszar stanie się niemożliwe. Niestety, w momencie zamykania Excela ustawienia te nie są zapisywane. Konieczne jest więc napisanie króciutkiego makra, które automatycznie będzie ustawiało odpowiedni obszar przewijania. Kod tego makra należy umieścić jako obsługę zdarzenia Worksheet_Activate.


        Prawym przyciskiem myszy należy kliknąć na zakładce nazwy arkusza, którego obszar ma ulec ograniczeniu, wybrać Wyświetl kod i wpisać następujący kod:

        Private Sub Worksheet_Activate ()
  Me.ScrollArea = "$A$1:$G$50"
End Sub


        
          

          [image: Okna Project Explorer oraz Properties]


          Rysunek 1-12. Okna Project Explorer oraz Properties

        


        Jak zwykle na końcu trzeba nacisnąć Alt/[image: ]+Q, aby powrócić do Excela i zapisać skoroszyt.


        Choć na pierwszy rzut oka nic nie będzie wskazywało, że obszar arkusza został ograniczony, to jednak przewinięcie ekranu lub zaznaczenie którejkolwiek komórki znajdującej się poza zdefiniowanym zakresem będzie niemożliwe.


        
          


          Ostrzeżenie


          Makra mające zaznaczyć zakres komórek wykraczający poza obszar przewijania arkusza (w tym także mające zaznaczyć całe wiersze i kolumny) nie będą w stanie wykonać tej operacji. Uwaga ta dotyczy przede wszystkim makr nagrywanych, w których często wykorzystywane są zaznaczenia komórek.

          

        


        Jeśli napisane wcześniej makra zaznaczają zakres komórek wykraczający poza obszar przewijania, łatwo można je zmodyfikować w taki sposób, by ustanowione ograniczenia nie miały wpływu na ich działanie. Wystarczy w tym celu wybrać polecenie Widok→Makra z grupy Makra lub Deweloper→Makra w grupie Kod albo za pomocą kombinacji klawiszy Alt/Option+F8 (we wcześniejszych wersjach jest to polecenie Narzędzia→Makro→Makra...) odszukać nazwę odpowiedniego makra, zaznaczyć ją i kliknąć przycisk Edycja. W pierwszym wierszu kodu należy następnie wpisać następującą instrukcję:

        ActiveSheet.ScrollArea = ""


        W ostatnim wierszu natomiast powinna znaleźć się instrukcja:

        ActiveSheet.ScrollArea = "$A$1:$G$50"


        Kod makra mógłby więc mieć następującą postać:

        Sub MojeMakro()
'
' Makro MojeMakro
' Makro zarejestrowane 19.09.2007 w OzGrid.com
'

'
  ActiveSheet.ScrollArea = ""
    Range("Z100").Select
    Selection.Font.Bold
  ActiveSheet.ScrollArea = "$A$1:$G$50"
  Sheets("Budżet dzienny").Select
  ActiveSheet.ScrollArea = ""
    Range("T500").Select
    Selection.Font.Bold = False
  ActiveSheet.ScrollArea = "$A$1:$H$25"

End Sub


        Powyższe makro wybiera komórkę Z100 i ustawia w niej czcionkę pogrubioną. Następnie uaktywniany jest arkusz o nazwie Budżet dzienny i zaznaczana jest na nim komórka T500, po czym czcionka w tej komórce zmieniana jest z pogrubionej na zwykłą. W makrze zamieszczono instrukcję ActiveSheet.ScrollArea = "" po to, by istniała możliwość zaznaczenia dowolnej komórki arkusza. Na koniec całej operacji przywracane jest ograniczenie obszaru przewijania. Następnie uaktywniany jest kolejny arkusz o nazwie Budżet dzienny, w którym znowu najpierw usuwane jest ograniczenie obszaru arkusza, dzięki czemu kod ma możliwość zaznaczania dowolnych komórek, a następnie ograniczenie to jest przywracane.

      


      
        
          Aktywowanie jedynie używanego zakresu

        


        Trzeci sposób, najbardziej elastyczny, automatycznie ogranicza obszar przewijania tylko do tych komórek, które są używane w arkuszu przechowującym kod źródłowy. Aby skorzystać z tego sposobu, należy kliknąć prawym przyciskiem myszy na zakładce nazwy arkusza, w którym ma zostać zdefiniowane ograniczenie obszaru przewijania, wybrać polecenie Wyświetl kod i wpisać poniższy kod:

        Private Sub Worksheet_Activate()
  Me.ScrollArea = Range(Me.UsedRange, Me.UsedRange(2, 2)).Address
End Sub


        Ponownie należy nacisnąć Alt/[image: ]+Q albo kliknąć przycisk X w prawym górnym rogu okna, aby powrócić do Excela i zapisać skoroszyt.


        Przedstawione makro będzie uruchamiane automatycznie za każdym razem, gdy uaktywniany będzie zawierający je skoroszyt. Kiedy jednak zajdzie potrzeba wpisania danych w komórkach leżących poza obszarem aktualnie używanym, może pojawić się problem. Aby go uniknąć, wystarczy użyć standardowego makra, które przywraca pełen obszar arkusza. W tym celu należy wybrać polecenie Deweloper→Visual Basic 



Ciąg dalszy dostępny w wersji pełnej.

  
    
      Rozdział 2. Sposoby na wbudowane mechanizmy Excela: Sposoby 17. – 43.


Dostępne w wersji pełnej.

  
    
      Rozdział 3. Sposoby na nazwy: Sposoby 44. – 49.


Dostępne w wersji pełnej.

  
    
      Rozdział 4. Sposoby na tabele przestawne: Sposoby 50. – 54.


Dostępne w wersji pełnej.

  
    
      Rozdział 5. Sposoby na wykresy: Sposoby 55. – 72.


Dostępne w wersji pełnej.

  
    
      Rozdział 6. Sposoby na formuły i funkcje: Sposoby 73. – 105.


Dostępne w wersji pełnej.

  
    
      Rozdział 7. Sposoby na makra: Sposoby 106. – 134.


Dostępne w wersji pełnej.

  
    
      Rozdział 8. Sposoby na współpracę różnych aplikacji: Sposoby 135. – 138.


Dostępne w wersji pełnej.

  
    
      Indeks


Dostępne w wersji pełnej.

  
    Kolofon

Dostępne w wersji pełnej.
Dostępne w wersji pełnej.
Dostępne w wersji pełnej.
OEBPS/Fonts/FreeSerifItalic.otf





OEBPS/Images/httpatomoreillycomsourcehelionimages1383924.png.jpg





OEBPS/Fonts/FreeSansBold.otf


OEBPS/Images/httpatomoreillycomsourcehelionimages1383936.png.jpg





OEBPS/Fonts/FreeSerif.otf


OEBPS/Fonts/FreeSerifBold.otf


OEBPS/Images/httpatomoreillycomsourcehelionimages1383928.png.jpg





OEBPS/Fonts/FreeSerifBoldItalic.otf


OEBPS/Images/httpatomoreillycomsourcehelionimages1383932.png.jpg





OEBPS/Images/httpatomoreillycomsourcehelionimages1383952.png.jpg
V] oxeras aosaca
‘Wyniki w tym tygodniu
C
o
oo
oo

Arkuszs






OEBPS/Images/httpatomoreillycomsourcehelionimages1383934.png.jpg






OEBPS/Images/httpatomoreillycomsourcehelionimages1383946.png
Project - VBAProject

& Thswortbook
= 3 Mokdes
2 voes






OEBPS/Images/httpatomoreillycomsourcehelionimages1383938.png.jpg
8 8 AR A A A






OEBPS/Images/httpatomoreillycomsourcehelionimages1383950.png.jpg
O ————a]

Moje szzblony | Moje szablony

. Baa

Podglad

Podolad riedostepny.






OEBPS/Images/httpatomoreillycomsourcehelionimages1383948.png
Microsoft Visual Basic - Zeszyt2 -

& He Edt Vew Insert Fomat

Ma- s ol

Project - ¥BAProject

V¥BAProject (2eszyt2)
= &5 Microsoft Exce Objects
Arkuszl (Arkusz1)
Arkusz2 (Arkus22)

Arkusz3 (rkusz3)
2 rhiirred

Properties - Arkusz1

fhuset worchest =]
habei | cotegoried |

iare) Azt
DisplayPageEreats False
isplayRightToleft False
Enableautoriter  False
EnableCalculation True
Ensbleoutining  False
EnablePivotTable  False
EnableSelection 0 - xiNoRestrictions
ame Aozt
Scrolares

Standardiicth 5,43






OEBPS/Images/httpatomoreillycomsourcehelionimages1383926.png.jpg





OEBPS/Images/httpatomoreillycomsourcehelionimages1383942.png.jpg
9] Bk Edya  widok  Wstaw
| zapisz T
Zapisz ko,
Druk

—
[

| Ustawienia strony,

@

Pisownia

Powiskszenie,

G| wyswiet kod






OEBPS/Images/httpatomoreillycomsourcehelionimages1383940.png.jpg
L2 ieninssesbonie it s s
@ Fe £ Yew et fomst Doy Eun
EE-d sonnoc

»uak ¥F

indow e
0

Toos 2o

progct-VaAbrject X

EETS I
B —
6 WAt Gesovtin)
Rty
€ e o)
2
s )
& i e
s )
4 viarroject esvasin)
[+ 8 voarojc zesytisin)
- % Vit s

ange (5yval Targer hs Excel Range)

es®), Target) Is Nething Then

Fhrkuazie, thrkseii)) Select






OEBPS/Images/orm_front_cover.jpg
100 sposohow na

EXGEL

2007 PL

TWORZENIE FUNKCJONALNYCH ARKUSZY

Wykorzystaj wszystkie mozliwosci Excela,
aby tworzyé funkcjonalne i efektowne arkusze

HELION

O’REILLY® David Hawley, Raina Hawley





OEBPS/Images/httpatomoreillycomsourcehelionimages1383930.png.jpg





OEBPS/Images/httpatomoreillycomsourcehelionimages1383954.png
Microsoft Visual Basic - Zeszyti|

Ele Edt View Insert Fomet De

=R TR Y |

Project - VBAProject

& Thsworbook

Properties - Arkusz3

I a——
habei | otegried |

iare) A3
DisplayPageEreats False
isplayRightToleft False
Enableautoriter  False
EnableCalculation True
Ensbleoutining  False
EnablePivotTable  False
EnableSelection 0 - xiNoRestrictions
ame Aozt
$4§1:4G550
Standardicth 5,43

iile -1 - isheetvisble






OEBPS/Images/httpatomoreillycomsourcehelionimages1383944.png.jpg
Properties - ThisWE}

[Workpook ~| [peforesave

Private Sub Uorkbook _BeforeSave (ByVal SaveAsUI ks Boolean, Cancel is Booleans|
Din iReply 4s Long
It SaversUI = Trus Then
IReply = NegBox ("Nie wotna zapisaé tego skoroszycu pod inna nazva. *
"Czy zapisaé skoroszyt?”, vhQuestion + vbOKCancel)
cancel = (1Reply = vbCancel)
If Cancel = False Then Me.Save
Cancel = True
Ena 12
End Sun






